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1.  Introduction
The SigmaSoft MAB-II for Software consists of a simple interface allowing easy 
administration, fast and accurate scoring, and flexible reporting. The interface is 
built around two main: a respondent database containing a list of people who 
have taken the test and an output window which contains any reports generated. 
Simple instructions, large fonts and oversize buttons make it easy for even the 
novice computer user to complete our tests on the computer. Administered tests 
are quickly and accurately scored, and can be printed in a number of standard 
report formats.

About this manual

This manual describes each of the functions of the SigmaSoft MAB-II for Windows 
Software in detail. Chapter 2 describes the installation process.  Registration is 
explained in Chapter 3. Chapter 4 contains a tutorial to get you up and running. 
Chapters 5 through 11 describe in detail the 6 options on the menu bar. Batch 
processing is explained in Chapter 12. Common troubleshooting tips are detailed 
in Chapter 13. A listing of files used and their explanation follows in Chapter 14. 
Uninstallation steps are outlined in Chapter 15. Finally, a glossary in Chapter 16 
lists all common terms used throughout the software and manual.

A great deal of effort has gone into making use of this software as intuitive as 
possible.  Users familiar with Windows software should have little trouble finding 
their way around the MAB-II for Windows software. However, it is crucial that the 
installation instructions contained in Chapter 2 be followed.  An understanding of 
the program settings described in Chapter 9 is also important.

Multidimensional Aptitude Battery-II (MAB-II)

Douglas N. Jackson, Ph.D. © 1984, 1998

The MAB-II consists of ten 7 minute timed tests that can be administered in 
any combination. With time for instructions and practice problems, a complete 
administration of the MAB-II takes about an hour and a half. The MAB-II is designed 
for use with high-school and adult populations (ages 16 through 74) and offers 
easier administration, more objective scoring and a greater ceiling than other 
popular intelligence measures. The MAB-II yields scores for each of the ten tests, 
a Verbal IQ score, a Performance IQ score and a Full Scale IQ score.

The Verbal tests are Information, Comprehension, Arithmetic, Similarities, and 
Vocabulary.  The Performance tests are Digit Symbol, Picture Completion, Spatial, 
Picture Arrangement, and Object Assembly.

The MAB-II test manual contains administration and scoring instructions, as well 
as detailed psychometric information.
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Technical Support

You may reach technical support for our software by one of the following methods:

	 Phone
	 Fax
	 Email

When you contact technical support, please have ready the serial number and 
version number of your software. The serial number can be found on the label of 
the installation CD. If you are calling by phone, it is also important that you have 
access to the computer on which you are running the software when you call. 
Determining the exact nature of a problem and then solving that problem is often 
an interactive process that requires access to your computer.

Contact 
Information

You may reach technical support by phone between the hours of 8:30 AM and 5 
PM Eastern Standard Time on our toll-free or direct lines:

United States	 SIGMA Assessment Systems, Inc. 
P.O. Box 610757 
Port Huron, MI  48061-0757 
USA 
Toll-Free	 800-265-1285 
Fax	 800-361-9411 
Hours	 8:30am - 5:00pm EST 
Email  	 software@SigmaAssessmentSystems.com 
Internet	 SigmaAssessmentSystems.com

Canada	 SIGMA Assessment Systems, Ltd. 
P.O. Box 3292, Station B 
London, ON  N6A 4K3 
Canada 
Phone	 519-673-0833 
Toll-Free	 800-401-4480 
Fax	 519-673-5905 
Toll-Free	 800-361-9411 
Hours	 8:30am - 5:00pm EST 
Email	 software@SigmaAssessmentSystems.com 
Internet	 SigmaAssessmentSystems.com

International	 SIGMA Assessment Systems, Ltd. 
P.O. Box 3292, Station B 
London, ON  N6A 4K3 
Canada 
Phone	 1-519-673-0833 
Fax	 1-519-673-5905 
Hours	 8:30am - 5:00pm EST 
Email	 software@SigmaAssessmentSystems.com 
Internet	 SigmaAssessmentSystems.com
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Copyright

The MAB-II for Windows installation CD is not copy-protected. You are encouraged 
to make backup copies of the installation CD. However, the MAB-II for Windows 
makes use of a protected counter. This software-based protected counter must be 
installed on one computer before the MAB-II for Windows can be used to generate 
reports. If you wish to generate reports from more than one computer, you must 
purchase software for, and register each computer separately. Any attempt to 
bypass the protected counter constitutes a violation of our copyright.

About the Company

SIGMA Assessment Systems, Inc. (SIGMA) have been creating respected 
assessments since 1967. We have a long list of satisfied clients in both the public 
and private sector, including NASA, Intel, DaimlerChrysler, Lucent Technologies, 
Towers Perrin, Nokia, AT&T, and Duke Energy, to name a few. Consultants find our 
products to be valuable complements to their service.

SIGMA is a founding member of the Association of Test Publishers, and has been 
providing products and services to human resource professionals, counselors, 
and psychologists for over 40 years. SIGMA publishes a variety of psychological 
instruments, including measures of ability, personality, and career interest.

Confidentiality

There are several steps you can take to protect the confidentiality of your client’s 
data.

1.	 In the security section of the Options|Program menu you will see a 
password for the program.  The default password is SIGMADEFAULT. You 
are encouraged to change this password before starting your testing. 
Whenever you load the software, you must enter a password to gain 
access.

2.	 In the security section of the Options|Administration menu. Whenever 
your client completes a test, you must enter a password to return to the 
Respondent Database.  This is the same password entered in step 1.

3.	 Ensure that reports and export files that have been generated are deleted. 
These files can be read by other programs. They can be regenerated later 
if needed again. 
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Password Protection Level C Test

Level C test should be password protected due to the sensitive nature of the data 
that is being stored for a respondent.  It is the recommendation that this test be 
password protected for start up and test administration exit functionality.

When the program is installed it will have a default password stored in the system.  

The initial installation password is SIGMADEFAULT.

Norms

The Multidimensional Aptitude Battery-II uses norms collected during a substantial 
renorming. The norming sample consisted of a systematic sampling of nine age 
groups in the United States and Canada. Individuals were sampled to ensure 
participation from a diverse sample of the general population in terms of race 
and ethnicity and North American geographic regions. Norms were comprised of 
equal numbers of males and of females. The nine age groups each contained 200 
persons, with the exception of the two oldest age groups, which contained 100 each.

The MAB-II norms are available for age groups ranging from 16 to 74.

The MAB-II does not make use of gender-specific norms.

Help on Help

Here are a list of common conventions used throughout the help manual:

File|Open	 Select the File item from the main menu, and select 
Open from the list.

Ctrl	 The “Control” or “Ctrl” key, normally at the bottom 
left of the keyboard.

Alt	 The “Alternate” or “Alt” key, normally to the right 
of the Ctrl key.

Alt-F4	 This is a keyboard shortcut. Press Alt, and then F4 
while holding down the Alt key. Then release the F4 
key and the Alt key.

Output	 Dialog boxes and windows are referred to in bold 
print.

List files as type	 A field or box inside a dialog box is listed in italics.
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2. Installation
The topics in this section are:
	 Required Equipment
	 Loading the Install Program
	 Installation
	 Network Installation
	 Registration
	 Password Protection
	 Program Updates

Required Equipment

The following equipment is required to install and run the MAB-II for Windows:

an Intel x86 compatible computer or better equipped with:

	 512 megabytes memory (RAM)

	 a hard drive with 12 megabytes of free space

	 Windows 98 / ME, NT / 2000 / XP, Vista or later.

	 a mouse

This represents the minimum configuration. However, additional memory and 
processor (CPU) speed will increase performance.

Loading the Install Program

The CAB for Windows files are stored on the installation CD in a compressed format. 
They can only be installed on your computer by following these steps:

•	 Place the installation CD into the CD drive on your computer.

•	 Display the Run dialog box from the Start Menu select Run.

•	 Type the drive letter of your CD drive followed by :SETUP (e.g. D:SETUP) and 
press the Enter key.

The Installation Wizard is displayed after you begin the installation program. To 
start installation click on the Next button. Click the Cancel button to abort the 
installation.
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Installation

Prior to installing the software, please exit any other SigmaSoft for Windows 
programs you have open. Follow the prompts.

There are two different ways to install the software: Automatic or Custom. 

Automatic
Most users will install using the Automatic settings. This means the SigmaSoft MAB-
II for Windows will be saved to default settings. Follow the prompts to complete 
the installation process, and skip to the Registration section.

Custom
Choose custom installation if you are installing a network server or client version 
of this program on a user with restricted computer access rights or with control 
of where and how it is installed. 

Follow the prompts to complete the installation process.
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Administrator or 
User

Choose Single user or Server if you are installing the software on a computer with 
multiple user accounts. 
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Network Installation

You may set up the SigmaSoft for Windows Software over a network with one 
copy of the software, running as the server, and permitting access to the server 
computer by clients on the network. Only one purchased copy of the software 
is necessary. A peer-to-peer network, such as Windows networking, is required 
to properly use the SigmaSoft for Windows Software over a network. All reports 
must be generated from this server computer, which holds the coupons. All other 
computers are then recognized as client computers by the software, when properly 
set up. Client computers can only edit respondent data and administer tests.

To set up the software on a server computer:

•	 Install the software and register on a computer to be designated as the 
server. This computer will hold the shareable database containing all of the 
respondent information.

•	 Ensure that the directory containing the software on the server computer is 
shared with full read/write access, including any shared Data folders.

•	 Password protect entry to the program in Options|Program and prevent 
exit from test administration in Options|Administration. This will prevent 
respondents from seeing or changing the responses of other respondents 
in the shared Data folder. Once configured, the password must be used by 
all clients before and/or after test administration, depending on your setup.
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To set up the software on client computers:

•	 Permanently map a network drive to the server computer.

•	 During install, choose Custom, Network, and follow the prompts.

To manually set up a network client after installation:

•	 Update the client's shortcut to use the /N parameter, followed by the path 
of the server's folder, and alter the paths in Options|Program to use the 
network drive letter.

Properly installed client copies will display Client Mode (Network) in the opening 
title screen, whereas unregistered standalone software will be displayed in 
Demonstration Mode.

Registration

The installation process is nearly complete when the Register? dialog box is 
displayed.

If you click on the Yes button, the install program loads the SigmaSoft MAB-II for 
Windows software and proceeds with registration. Press F1 for help in the SigmaSoft 
MAB-II for Windows program, or read the chapter on Registration which follows.

If you click on the No button, you may register the software any time you next 
run the program.

If you did not successfully complete each of the installation steps, the MAB-II 
Software will not have been properly installed and you will have to restart the 
installation process from the beginning.
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Password Protection

Level C tests should be password protected due to the sensitive nature of the data 
that is being stored for a respondent.  It is the recommendation that this test be 
password protected for start up and test administration exit functionality.

When the program is installed it will have a default password stored in the system.  

The initial installation password is SIGMADEFAULT.

The user will be presented with a Password login screen as shown below.

Program Updates

The SigmaSoft for Windows Software is periodically updated, and there is currently 
no charge for minor upgrades. Upgrades may be installed to the same directory 
as your current version. Your registration and number of coupons will remain 
unchanged, as well as any existing respondent data.

You may download the most recent version of our software as well as demonstration 
versions of our other instruments on our website:

•	 http://SigmaAssessmentSystems.com

If you do not have internet browser access but do have internet mail, we can email 
you an update. Send an email request to: 

•	 software@SigmaAssessmentSystems.com
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3. Registration
The topics in this section are:
	 Why register?
	 Registration limitations
	 How to register
	 Moving the registration to another computer

Why Register?

The SigmaSoft for Windows Software is usage-controlled. Before you can use all of 
its features, registration is required. A password is then provided that will complete 
the installation of the software on your computer. This enables the protected 
counter that keeps track of the number of coupons you have purchased. Coupons 
are required to generate reports.

Registration Limitations

The software must be registered to a local drive on a computer. It cannot be 
registered to a remote computer on a network. Only the computer which has been 
registered can access the coupons. Once the software is registered, you may not 
move it to another directory or computer by yourself. You must contact SIGMA 
for a password to remove the coupons and then contact us again to add them to 
another computer. If you wish to uninstall the software, you must contact us to 
have the coupons removed so you will receive credit for unused coupons.
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How To Register

You may register our software by one of the following methods:
	 Phone
	 Fax
	 Email

1.	 Run the SigmaSoft for Windows Software.

2.	 At the opening screen, select Register.

3.	 Complete the Registration Information window and click the Register 
button. This will display the Registration window.
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Registration 
window

Validation Code
This code is generated by the program when you are about to register the software.

Current Coupons
The current number of coupons installed is displayed. If you are registering for 
the first time, the number of coupons is zero.

Serial Number
You are given a serial number when you purchase the software. This number will be 
used to identify you when you call in to add coupons or ask for technical support.

Add Coupons
If you are adding coupons when you are registering, enter the number of coupons 
you wish to add here. If you are not adding coupons, enter zero.

Password
Enter the password you are given. To obtain a password, see the section How to 
Register and follow the instructions.

Now button
If you have entered a password, click on this button.

Later button
Click on this button to register later, by fax or by email, or if you want to make 
changes to your registration.

Cancel button
This button halts the registration process. Registration information, including the 
validation code will be lost. You are given a warning if information has been changed 
and not saved. If you receive this warning, click on the Ok button to continue the 
cancel. Click on the Cancel button to return to the Registration window.
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Register by Phone

1.	 You are asked to provide the information in the Registration window, 
including the initial number of coupons you are purchasing.

2.	 Enter the Serial Number, Coupons and Password in the appropriate boxes, 
and click the Now button. If all goes well, the message “Registration 
successful” is displayed, along with the number of coupons added.

Register by Fax or 
Email

1.	 Indicate how many coupons you will initially install by entering the amount 
in the Add Coupons field.

2.	 Click the Later button.

3.	 Answer Yes to print out the order form.

4.	 Exit the software by answering Ok to any remaining prompts and selecting 
File|Exit from the menu.

	 Follow one of the methods below:
Fax

5.	 Complete the information on the order form.

6.	 Fax the order form to one of the following numbers:
	 United States	 SIGMA Assessment Systems	 1-800-361-9411
	 Canada		  SIGMA Assessment Systems	 1-519-673-5905 
							       1-800-361-9411
	 International	 SIGMA Assessment Systems	 1-519-673-5905

You will receive return fax containing your password. Proceed to Step 7.
Email

5.	 Use NotePad to edit the REG.TXT file found in C:\Program files\Test Name.  
Complete, then save the information.

6.   Address your internet email to:
	 software@SigmaAssessmentSystems.com
 
   For the subject line please use:
	 Windows Software Registration    
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	 Attach or insert the REG.txt file into your message, and then send the 
message.

	 You will receive return email containing your password.

7.	 Run the SigmaSoft for Windows Software, and choose Register at the 
opening screen.

8.	 Click the Register button in the Registration Information window.

9.	 In the Registration window, enter the Serial Number, Coupons and 
Password in the appropriate boxes, and click the Now button. If all goes 
well, the message “Registration successful.” is displayed, along with the 
number of coupons added.

Moving the registration to another computer

You may not simply move or copy the software to another computer or directory. 
Doing so will invalidate your registration and result in the loss of coupons. You will 
then have to call technical support to re‑register the software.

To move the 
registration to 

another location:

1.	 Uninstall the software. See the Uninstallation section.

2.	 Contact technical support with your removal validation code.

3.	 Install the software in the new computer or directory.

4.	 Register the software. You may add coupons back at the same time you 
register the software, by providing your removal confirmation code when 
you re-register.
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4. Tutorial
Introduction

The tutorial will interactively teach you how to add a respondent, administer the 
test and print a report. You can run the on-line tutorial by loading the help file and 
selecting Tutorial or by selecting Tutorial from the Help Menu of the SigmaSoft 
for Windows Software.

Part One - Adding a respondent

If you have not done so already, start your SigmaSoft MAB-II for Windows Software 
now.

Click on the Ok button to continue past the About screen.

The Respondent Database window is displayed. If you inadvertently cover it up 
with the Output Window, display it again using one of two methods:

1.	 Select Window from the menu bar, then Respondent Database from the 
drop-down list. This method of selecting from the menu will be displayed as 
“Window|Respondent Database”.

-or-

2.	 You may also select the Respondent Database by clicking on a portion of it 
that appears on your screen.

If the message “You must open a respondent database first” is displayed, create 
a new respondent database file by selecting File|New and entering a new name 
in the Create new respondent database dialog box, such as “TEST”.
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Add a respondent in one of two ways:

1.	 Click on the Add button

-or-

2.	 Press Alt-A on your keyboard by pressing and holding the Alt key, then pressing 
the A key and then releasing both keys. This is called using the keyboard 
shortcut, the shortcut key being the underlined letter on the button.

You are presented with the window named Edit Respondent Information.

Enter in a last name, press the Tab key to move to the next field. Enter a first name, 
press Tab and press Tab again to move past the middle name without entering 
anything. Continue entering data and tabbing until the Administer button is 
highlighted (a dotted line appears around the inside of the button).

Administer the test now by pressing the space bar while the Administer button 
is highlighted, or press the Alt-D shortcut or by clicking on the Administer button 
with your mouse cursor.  

When you start the test, the administration startup screen explains to the respondent 
how to answer the questions. This would be the time you would bring in a client 
to take the test during normal operations.



Page 4-3

To finish press the F key. By default, the Check password at administration end 
check box is checked in the Options|Administration window, the password will 
be requested before returning to the Edit Respondent window. The password will 
also be requested if you exit early from the test using the Alt-F4 shortcut.

Click on the Yes button in the Edit Respondent Information window to save the 
changes to the respondent database.

Part Two - Printing a sample report

If you have not registered your software, administration will be limited to the 
instruction screens and practice problems, and you will not be able to generate a 
report. If you still wish to print a sample report, follow the instructions below and 
continue to Part Three. If your software is registered and you want to generate 
a report based on the test you just completed, then skip to Part Three - Printing 
a report now.

Change to the sample respondent database using one of three methods:

1.	 Select File|Open from the menu.

2.	 Press the Ctrl-O shortcut

3.	 Click on the file open icon  on the speed bar.

In the Open existing respondent database dialog box, select the file SAMPLE.DAT 
and click the Ok button.

Select the first sample respondent, and continue with Part Three.
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Part Three - Printing a report

Make sure the respondent you just added is selected. Click on the Report button. 
Select the Basic Report radio button from the list and click on the Ok button.

The respondent information will be displayed again in the Generating Report 
window. Click on the Yes button to begin generating the report.

After processing is complete, a report is generated in the Output window, which 
is then displayed.
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At this time, you can choose to save the report as a .PDF on the computer, or 
simply exit the program. If you do not save the report, you can generate it again 
later from the respondent data without using additional coupons.

This concludes the tutorial. Exit the SigmaSoft for Windows Software by selecting 
File|Exit or using the Alt-F4 shortcut.
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5. Main Menu
The Main Menu is located at the top of your SigmaSoft for Windows Software 
screen. When you click on a menu item, it displays another menu of options. 
The status line at the bottom of the window will show a brief hint as to what the 
menu option does. Menu items are enabled only when they apply to the current 
operation. Below the Main Menu lies the speed button bar containing one-click 
buttons for common operations.

The menu topics in the Main Menu are:
	 File
	 Edit
	 Coupons
	 Options
	 Window
	 Help

Speed Buttons

The speed button bar below the main menu consists of the following icons:

When you click on the speed button icon, it immediately carries out the associated 
action, as listed below. If you place the cursor over a button and let it rest for a 
moment, a hint to what the button does is displayed above the button.

	  File|New		   Edit|Cut		   Bold	

 File|Open		   Edit|Copy		   Italic	

 File|Save		   Edit|Paste		   Underline	

 File|Print		   Edit|Format		   File|Exit	

 Zoom In		   Zoom Out

Many of the speed buttons also have keyboard shortcuts.
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Keyboard Shortcuts

To increase your efficiency, many of the main menu commands have keyboard 
shortcuts. The keyboard shortcut is also listed on the menu itself next to the 
description of the item. To use a two key shortcut such as Ctrl-N, press the Ctrl 
key, hold it down and press the N key. Then release the N key and the Ctrl key.

Many buttons and controls have an underlined character. Press the Alt key and 
this character to activate the keyboard shortcut. For example, the Options menu 
can be activated by pressing the Alt-O sequence.

Some of the keyboard shortcuts can also be found on the speed button bar.

Menu Command	 Keyboard Shortcut

	 File|New	 Ctrl-N	

	 File|Open	 Ctrl-O	

	 File|Save	 Ctrl-S	

	 File|Export	 Ctrl-E	

	 File|Import	 Ctrl-I	

	 File|Print	 Ctrl-P	

	 File|Exit	 Alt-F4	

	 Edit|Cut	 Ctrl-X	

	 Edit|Copy	 Ctrl-C	

	 Edit|Paste	 Ctrl-V	

	 Edit|Select All	 Ctrl-A	

	 Edit|Deselect All	 Ctrl-D	

	 Edit|Find	 Ctrl-F	

	 Edit|Replace	 Ctrl-R	

	 Edit|Format Character	 Ctrl-T	

	 Edit|Format Paragraph	 Ctrl-H	

	 Edit|Insert Page Break	 Ctrl-B	

	 Help	 F1
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6. File Menu
The file menu contains items which affect the Respondent Database window, and 
the Output window.

A menu item will be greyed out (dimmed) if it does not apply to the currently 
selected window or function.

The items in the File Menu are:
	 New
	 Open
	 Save
	 Save As
	 Rebuild
	 Export
	 Import
	 Print
	 Exit

File|New

When the Respondent Database window is selected, File|New creates and opens 
new respondent data files. All respondent information will be saved in this file. If 
you specify the name of a file that already exists, the contents of this file will be 
erased. Use File|Open to open existing respondent data files. By default, respondent 
data files are created in the directory specified in the Options|Program window.

When the Output window is selected, File|New erases its contents.

Keyboard shortcut	 Ctrl-N	

Speed button	 	
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File|Open

Before you can either import data, edit respondent data or generate reports, you 
must specify which respondent data file you wish to use. This option allows you to 
open an existing respondent data file. If you wish to create a new file or overwrite 
an existing file, use the File|New option.

By default, respondent data files are created and stored in the directory specified 
in the Options|Program menu.

When the Output window is selected, File|Open allows you to retrieve a previously 
saved report in RTF format.

Keyboard shortcut	 Ctrl-O	

Speed button	 	

File|Save

All changes to your Respondent Database window are saved immediately, so the 
File|Save option is disabled when this window is selected.

When the Output window is selected, this option saves all information in the 
Output window. If you have not named the report in the Output window, you are 
prompted with a Save Output dialog box.

Keyboard shortcut	 Ctrl-S	

Speed button	

File|Save As

Use this option to save all the data in this window to a different file. You are 
prompted with a dialog box entitled Save respondent database as.

Data in the Output window may be saved with any name by using the File|Save 
As command. Enter the new name in the Save output as dialog box. Files are 
saved in RTF format.

File|Rebuild

Rebuild the currently opened respondent database file. Use this feature if a 
respondent database has become corrupted or if you have deleted a lot of data 
and wish to reduce the size of a respondent database file.
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File|Export

When the Respondent Database window is selected, you may select some or 
all of the respondents to export into a separate file to be imported by another 
software program.

Highlight any respondents using the keyboard and/or mouse and select File|Export. 
You are prompted with an Export Data dialog box and may change the export file 
type with the “Save file as type” list box.

The export file types supported are:
	 Comma Delimited
	 Tab Delimited
	 Fixed Format Ascii

For more information on file formats, refer to the Import/Export File Formats 
section.

The exported files contain data for responses and scales.  If the Basic Report has 
been purchased for the respondents output, then the export file will contain all 
the data that is also contained in the Data Report in the formats above.  The extra 
data will not be exported without the purchase of at least a Basic Report.  This 
allows the administrator to import respondent data into an external software 
program like Microsoft Excel.

Keyboard shortcut	 Ctrl-E
File|Import

When the Respondent Database window is selected, you may import respondent 
data exported by another software program, provided it is formatted properly.

After you select File|Import, you are prompted with the Import Respondent Data 
dialog box. To see files of other types which you may import, change the “List files 
as type” list box.

The import file types supported are:
	 Comma Delimited
	 Tab Delimited
	 Fixed Format Ascii

For more information on file formats, refer to the Import/Export File Formats 
section.

When the Output window is selected, File|Import allows you to insert an RTF file 
at the cursor location.

Keyboard shortcut	 Ctrl-I	



Page 6-4

File|Print

Send the contents of the Output window to the currently selected Windows 
printer. You may select which pages to print, the number of copies, and whether 
or not the copies are collated.

To select a different printer or change your printer setup, select the Printer and 
Page Setup option.

Keyboard shortcut	 Ctrl-P	

Speed button			   	

File|Exit

To exit from the SigmaSoft for Windows Software, select File|Exit. You are warned 
if the Output window contains unsaved data. All data in the Respondent Database 
window has already been saved.

Keyboard shortcut	 Alt-F4	

Speed button	
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7. Edit Menu
Most of the options on Edit Menu apply to the Output window only. Use these 
options to change the appearance of any reports or to find specific information 
within the report.

The items in the Edit menu are:
	 Cut
	 Copy
	 Paste
	 Select All
	 Deselect All
	 Find
	 Replace
	 Format Character
	 Format Paragraph
	 Insert Page Break

Edit|Cut

Copies the selected text from the Output window to the clipboard and removes 
the selected text. Use Edit|Cut when you want to move text from one part of a 
document to another. Move the cursor to where you want to place the new text 
and select Edit|Paste.

Keyboard shortcut	 Ctrl-X	

Speed button	 	

Mouse	 Right click, then select Cut from the menu	

Edit|Copy

Copies selected text from the Output window to the clipboard. Use Edit|Copy 
when you want to copy text from one part of a document to another. Move the 
cursor to where you want to place the new text and select Edit|Paste.

Keyboard shortcut	 Ctrl-C	

Speed button	 	

Mouse	 Right click, then select Copy from the menu
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Edit|Paste

Pastes the text from the clipboard to the current cursor location in the Output 
window. Any selected text will be replaced by the text being pasted.

Keyboard shortcut	 Ctrl-V	

Speed button	 	

Mouse	 Right click, then select Paste from the menu

Edit|Select All

Selects all of the text in the Output window. You may then apply font changes to 
the entire text, copy, cut or delete the text entirely.

If the Respondent Database window is selected, then all of the respondents will 
be selected. You may then Delete, Edit, or create a Report on all of the selected 
respondents.

Keyboard shortcut	 Ctrl-A	

Edit|Deselect All

If the Output window is selected, this option removes any text selection, without 
removing the text.

If the Respondent Database window is selected, then all of the respondents will 
be deselected when this option is used.

Keyboard shortcut	 Ctrl-D		
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Edit|Find

Edit|Find displays a Find dialog box in which you enter any word or name you 
want to find.

When the Output window is selected, Edit|Find will find and select your search 
word(s) among the report text. If you continue your search and find more text, 
only the newly found text remains selected.

When the Respondent Database window is selected, Edit|Find searches the text 
displayed in the respondent list box, which contains the last and first name fields, 
gender, and the ID number of the respondent. Enter your search name in text box 
and click on the Find button. Any respondent names found will be selected, and 
you may continue searching by clicking on the Find Next button. The Edit|Find 
command starts the search with the first respondent in the list before or after the 
currently selected respondent.

Keyboard shortcut	 Ctrl-F		

Edit|Replace

The Replace dialog box allows you to search for and replace text within your Output 
window. Enter your find and replace text strings and click on the Find Next button. 
When the text you wish to replace is highlighted, click on the Replace button. Click 
on the Replace All button to replace all text starting from the current location.

Keyboard shortcut	 Ctrl-R	

Edit|Format Character

Choosing Edit|Format Character displays the Font dialog box which allows you to 
change the font type, size, and appearance of text in the Output window. If there 
is no text selected, then the font changes apply to new text typed in. If a selection 
is highlighted, the changes apply only to the selected text.

Keyboard shortcut	 Ctrl-T	
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Edit|Format Paragraph

You may change the indentation and spacing of paragraphs, and tab spacing with 
the Format Paragraph dialog box. Changes are applied to the current paragraph.

Indent
The left and right indent offset text the indicated amount from the left and right 
margins for the current paragraph. The first line indent offsets the first line of the 
paragraph only by the indicated amount.

Align
A left alignment lines up the left hand side of the paragraph with the left margin. A 
right alignment aligns the right hand side of the paragraph with the right margin. 
Choosing a center alignment sets up the current paragraph with each line centered 
between the margins. If you choose an alignment of justify, the text is adjusted 
to line up with both the left and right margins.

Border
To add a border to either the top, bottom, left or right side of the current paragraph, 
check the appropriate box in the Border section. To remove a line, uncheck the 
appropriate box.

Shading
To add shading to a paragraph, change the percentage value in the Shading section. 
Values can vary from 0 percent to 100 percent.

Keyboard shortcut	 Ctrl-H	

Edit|Insert Page Break

Inserts a page separator in the Output window at the location of the cursor.

Keyboard shortcut	 Ctrl-B
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8. Coupons Menu
The options on this menu allow you to examine the status of your coupons, and 
to add scoring coupons to the SigmaSoft for Windows Software.

The Coupons Menu is available only when the software is registered.

The items in the Coupons Menu are:
	 Add
	 Status

Coupons|Add

When you have used up your coupons you may purchase more by contacting 
SIGMA with the information provided by the Add Coupons window.

You may add coupons by one of the following methods:
	 Phone
	 Fax
	 Email
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Add Coupons window

Serial Number
The serial number is assigned to you by SIGMA when you initially register the 
software. Since this number does not change, the field is not editable

Current Coupons
This field displays the current number of coupons installed in the protected 
coupon counter.

Validation Code
The validation code is an essential piece of information which you give to SIGMA. 
If you are adding coupons by mail, fax, email, or purchase order, you must use 
the Later button to save the validation code. If you do not, the validation code 
will change, and any passwords you receive will not work.

Add Coupons
Enter the number of coupons that you are ordering. This number must exactly 
match the order you give to SIGMA.

Password
Enter the password you receive from SIGMA in this field.

Now button
When you click on the Now button, and the password and coupons are correct, 
the new coupons will be added immediately.

Later button
When you click on the Later button, the validation code and coupon information 
is saved. When asked to print an order form, answer Yes. Use this form with any 
orders for coupons.

Cancel button
If you click on the Cancel button, any password you have received will no longer be 
valid. A dialog box will warn you that this will happen. If you have not purchased 
a password, click on the Ok button in the dialog box to exit. Click on Cancel in the 
dialog box to return to the Add Coupons window.
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Adding coupons

1.	 Select Coupons|Add from the main menu.

2.	 Enter the number of coupons you wish to add in the Add Coupons field.

See step 3 (add by phone or add by fax/email).

To add coupons by 
phone:

3.	 Call one of the following numbers:
	 United States	 SIGMA Assessment Systems	 1-800-265-1285
	 Canada		  SIGMA Assessment Systems	 1-800-401-4480
	 International	 SIGMA Assessment Systems	 1-519-673-0833

4.	 Provide billing details, and method of payment.

5.	 Provide the serial number, validation code and number of coupons you wish 
to SIGMA.

6.	 Enter the password given to you by SIGMA.

7.	 Click the Now button.

To add coupons by 
fax or email:

3.	 Click the Later button.

4.	 Answer Yes to print the order form.

5.	 Use NotePad or another editor to edit the COUPON.TXT file, found in C:\
Program files\Test Name, and complete the blanks on the form, providing 
billing details, and method of payment.

Follow one of the methods below:
Fax:

6.	 Print and fax the COUPON.TXT file to one of the following numbers:
	 United States	 1-800-361-9411
	 Canada		  1-519-673-5905 
			   1-800-361-9411
	 International	 1-519-673-5905
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Email:

6.	 Email to the following internet address:

	 software@SigmaAssessmentSystems.com

	 For the subject line please use:

		  Coupon Order

	 Attach or insert the COUPON.TXT file into your message, and then send the 
message.

7.	 When you receive your reply email, select Coupons|Add, enter the password 
given, and click on the Now button.

Coupons|Status

The Coupon Status window displays the name and address to whom the software 
is registered, as well as coupon information. The coupon information displays the 
serial number of the program and the remaining coupons left.
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9. Options Menu 
The items on the Options Menu allow you to change the fonts, directories, security 
options and languages of your SigmaSoft for Windows Software.

The items in the Options Menu are:
	 Program
	 Administration
	 Report

Options|Program

The Program Settings window allows you to set your data, import and export 
directories, main screen font, startup security options, and number of days your 
backup files are kept.
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Program Settings window

Program 
Directories

The Data directory points to the location of the respondent database files. The 
Import directory points to the location of files to be imported, normally exported 
by other programs. Report files are saved in the Output directory by default.

Screen Font
Customize the font used in most of the dialog boxes by changing the Screen Font. 
Test any changes you make. Too large a font will result in the truncation of button 
labels and other text. Too small a font be difficult to read. A 10 point to 11 point 
bold font is recommended.

Security
The program entry is password protected.  The initial password has be set to 
SIGMADEFAULT. To change the password protect entry to the SigmaSoft for Windows 
Software, enter a new password in the Password edit box. The Check password 
at program start check box defaulted to always checked. A password prompt will 
appear each time the software is loaded. The password is also used at the end of 
administration, if so configured in the Options|Administration. If you remove the 
password, the Check password at program start check box is automatically set to 
SIGMADEFAULT. Choose a password that you will remember. Enter this password 
after initial installation. Should you forget your password, please contact SIGMA 
Assessment Systems technical support.

This section is greyed out if the software is being run in client mode. Any changes 
must be made on the server computer.

Backup
You may optionally have automatic backups made whenever you make changes to 
respondent data or administer tests. Enable backups by checking off the Backup 
files check box. The Number of days to keep backups edit box defines how long 
backups will remain. Old backup files are deleted after the specified number 
of days. Backup files are named BKddhhmm.CSV and are stored in the Import 
directory. The ddhhmm corresponds to the current day (01-31) and the hour and 
minute the file was created. To recover information on a respondent, import the 
appropriate file. When you delete a respondent, it is also backed up, however, 
the name of the file begins with “DL” instead of “BK”.
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Options|Administration

The Administration Language radio box controls what language will be used while 
administering the test. 

Administration Settings window

Administration 
Language

The Administration Language radio box controls what language will be used while 
administering the test. The English (USA) option will use imperial measures (e.g., 
inches, pounds, etc.) to present quantitative information, whereas the English 
(International - Metric) option will use metric measures (e.g., metres, grams, etc.).

Administration Font
You may choose what font is used during the test administration by changing this 
font. Test any changes you make. Too large a font will result in the truncation of 
instructions and item text. Too small a font will be difficult to read. An 18 point to 
22 point bold font is recommended.
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Performance 
Images

To disable the display of images during the Performance tests, clear the Show 
performance images check box. By default, this box is checked, so that images 
are displayed on screen. If the quality of the images is poor or the speed of the 
display is too slow, uncheck this box and use the printed Performance test booklet 
when administering the Performances tests.

Administration 
Security

The password entered in the security section of Options|Program must be entered 
after the test is finished if the Check password at administration end box is checked.

It is strongly recommended that the Disable Windows keys option is checked. This 
will prevent keystrokes such as Alt-Tab, Ctrl-Esc, Ctrl-Alt-Del and the Windows 
key from allowing the test taker to switch to or run another program. Please note, 
however, that this option enables a “keyboard hook” program for the duration of 
the test which may be incompatible with other keyboard software.

This section is greyed out if the software is being run in client mode. Any changes 
must be made on the server computer.

Options|Report

The Report Settings window allows you to customize the appearance of the 
generated reports by selecting a default language and font. You may choose to 
print any warnings in the report or only display a warning on screen when there 
are too many missing responses.
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Report Settings window

Report Language
The Report Language radio box controls what language will be used for generating 
reports.

Report Appearance
You may choose what font is applied to reports by selecting the Font button. The 
current font is listed on the button. Make sure you test any changes you make. 
Too large a font will result in the report formatting problems. An 11 point font is 
recommended.

The Printer and Page Setup button launches the Printer and Page Setup window, 
which allows you to change the printer, paper and margin settings.

Report Destination
In this section you may choose where the generated report will be sent: to the 
Output window to preview and edit the report, or directly to the printer specified 
in the Printer and Page Setup window.

Address
If you wish to include your address, as shown in your registration, on page 1 of 
each report, check the Include address on report check box.
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Printer and Page Setup

Use this window to change the appearance of the printed report and the Output 
window. The Printer and Page Setup window contains three sections labelled 
Printer Settings, Paper Settings and Margin Settings.

Printer and Page Setup window

Printer Settings
This section allows you to choose a printer from the list of printers available to 
your computer.

Paper Settings
To change the paper size, choose a paper type from the Paper Size list box. To the 
right of the paper type are the dimensions of that type. The Paper Bin list box lets 
you choose the origin of the paper.

The Duplex list box allows you to determine whether and how the pages will be 
duplexed, if your printer supports double-sided printing. You may duplex vertically 
(like a book) or horizontally (like a tablet) or not at all. The number of copies are 
entered in the Copies box.
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The Orientation list box allows you to determine whether the report is printed in 
Portrait mode (top to bottom) or Landscape mode (rotated 90 degrees). When 
the Collate Paper check box is checked, and when more than one copy is printed, 
each report will be printed separately, as opposed to each page being duplicated 
separately.

Margin Settings
If your report does not fit on the page properly, you can change the margins from 
the top, bottom, left and right edges of the page. All values are in inches, regardless 
of the paper size. Make sure you test any changes you make.
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10. Window Menu
To change between windows, select either Respondent Database or Output 
from the Window Menu. The windows are rearranged, and the window that you 
selected is brought to the front.

The items in the Window Menu are:
	 Output	
	 Respondent Database
	

Window|Output

The Output window displays the results of any reports generated from the 
Respondent Database window. You may edit, load, save and print the contents 
of this window.

The topics in this section are:
	 Selecting and Deselecting Text
	 Changing Fonts
	 Using Bold, Italic and Underline
	 Printing

Output Window
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Selecting and 
Deselecting Text

Many of the following commands require that you have text in the Output 
window selected. There are three ways to select text: menu commands; keyboard 
commands; and mouse commands.

To select text...

1.	 with a menu command (selects all of the text in the Output window):

a.	 To select all text, use the Edit|Select All menu option, or the Ctrl-A 
shortcut.

2.	 with the keyboard:

a.	 Press the Shift key.

b.	 Move the cursor using the arrow keys in the direction which you 
wish to select text.

3.	 with the mouse:

a.	 Press and hold the left mouse button where you wish to begin the 
selection.

b.	 While holding down the button, move the mouse to the end of the 
selection.

c.	 Release the left mouse button.

To deselect text...

1.	 with a menu command (deselects all of the text in the Output window):

a.	 To select no text, use the Edit|Deselect All menu option, or the Ctrl-D 
shortcut.

2.	 with the keyboard:

a.	 Move the cursor using the arrow keys.

3.	 with the mouse:

a.	 Click the left mouse button once inside the Output window.

Changing Fonts
You can change the font of the entire report or sections of the report. You can 
permanently change the font used in all future reports by changing the initial 
report font.

To change the report font:

1.	 Select all or part of the text in the Output window:

2.	 Choose Edit|Format Character, or the Ctrl-T shortcut.

3.	 From the Font dialog box, change the font name, size and style.

4.	 Click on the Ok button.
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To change the initial report font:

1.	 Select Options|Report.

2.	 Click on the Report button.

3.	 Select a font, font size and attributes from the Font dialog box and click on 
the Ok button.

Using Bold, Italic or 
Underline

Use bold or italic to emphasize text, or underline to create a line under text in 
the Output window. When you move the cursor to a section of the report with 
these styles used, the icons in the button bar pop in or out to show the style 
under the cursor.

To change the style of the report:

1.	 Select a portion of text.

2.	 Click on the Bold, Italic or Underline speed button. If the button is already 
pushed in, clicking it again turns off the style.

Printing
After generating a report or making changes to the Output window, you may print 
a report by selecting File|Print, using the Ctrl-P shortcut, or clicking on the Print 
speed button. After the Print dialog box appears, you may select which pages to 
print, and how many copies of each.
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Window|Respondent Database

This window displays the contents of the respondent data file that have been 
added, scanned or imported into the database. Each item contains demographic 
data, responses and coupons. The Edit, Delete and Report buttons are available 
only when one or more respondents in the list are selected.

Respondent Database window

The filename of the current database is listed in the upper left corner of the 
window. Below the filename is the list of respondents in the database. Each item 
in the list contains the last name, first name, gender and identification number. A 
status line at bottom left shows the number of the currently selected record, the 
total number of records, and the number of selected records.

Add
To add respondent data, click on the Add button. The Edit Respondent window 
is displayed. After the demographic data is entered, you may administer the test 
or enter raw scale scores.

Edit
Double-click on a respondent name, or select a range of respondents and select 
Edit, you may change the demographic data or edit the responses in the Edit 
Respondent window.

Combine
The Combine Verbal and Performance Data window allows you to combine 
separately administered or imported Verbal and Performance batteries into a 
single record.
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Delete
Select one or more respondents to delete. You are prompted for confirmation 
before each deletion takes place with the Delete Respondent Data window. 
Deleted respondents are stored in files named DL*.CSV to your Import directory 
(see Options|Program). If you accidentally delete records, restore them by 
importing one of these files.

Report
To generate reports from the respondent data, click on the Report button. If you 
wish to generate reports for all respondents, press Ctrl-A first, or use your mouse 
to highlight all of the respondents in the database. You are then prompted for 
the type of report you wish to generate. You are asked for confirmation before 
any reports are sent to the Output window for printing. The Generating Report 
window displays basic respondent information and current scoring level.

Sort
By default, the respondents are listed in the order that they were added to the 
database. If you wish to sort by last name, check the box labelled Sort. To return 
the list to its natural order, uncheck the Sort box.
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Edit Respondent

The Edit Respondent Information window allows you to add to or change the 
demographic information for a respondent, as well as the scale scores and responses. 
The window also displays the current coupon level for the respondent. From here 
you administer the test to the respondent.

Edit Respondent Information window

Respondent 
Demographics

Use the Last Name, First Name, Middle Name and ID Number edit boxes to identify 
the respondent. Type in M or F in the Gender edit box to indicate the respondent’s 
sex. Enter the respondent’s age in the Age edit box. The contents of the Age edit 
box decide which norms are used. If left blank, norms for the 25-34 age group 
are used.

Coupon Level
The coupon level allows you to determine how many coupons have been used for 
a respondent. If a report you wish to generate costs the same or less in coupons, 
you may generate it again without using more coupons.
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Administer
Click on the Administer button to display the Administration Setup window. 
Select the test you wish to administer and then click on Ok to display the first 
administration screen. At this time, bring in the respondent to take the test. To 
exit early, press Alt-F4. If you enabled the Check password at administration end 
option in Options|Administration, you need to enter a password to proceed. The 
responses are not saved until you save the respondent data.

In demonstration mode, only the instructions and practice problems
of the MAB-II are presented.

Edit Responses
To manually edit the responses, click on the Edit Responses button. The Edit 
Responses window is displayed.

Edit Scale Scores
To manually alter the scale scores, click on the Edit Scale Scores button. The Edit 
Scale Scores window is displayed.

Yes button
Click this button to save any changes you have made. The data will be checked 
before it is saved and you are warned if any errors are found. You are warned if 
any of the demographic information is missing. You are also warned if responses 
and scale scores do not match. If responses or scale scores have been changed, 
the coupon level will be set to zero. Each of the warning messages will allow 
you to proceed by clicking on the Ok button, or return to the Edit Respondent 
Information window by clicking on the Cancel button.

No button
Any changes you have made will not be saved. This includes responses from 
administration. You are warned if data will be lost.
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Administration

Selecting Tests

To begin administration, select from the list of tests presented in the Administration 
Setup window. By default all tests are selected. If you are restarting a test, click 
on None and then select only the test you wish to run. When the tests to be used 
are selected, click on the Ok button to begin administration. Because each test 
begins with a fresh 7 minutes, existing responses from a previous administration 
are erased at the start of each test. You will be warned before this happens.

Select tests to 
administer

Place a check mark beside the test you wish to administer.

All button
Selects all of the tests.

None button
Deselects all of the tests.
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Verbal button
Selects the verbal tests (the first five tests).

Performance 
button

Selects the performance tests (the last five tests).

Ok button
When you click on the Ok button to start the administration, the first screen, “What 
is the MAB-II?” displays general help instructions for the respondent.

General Instructions

Three more instruction screens follow: “What is each test like”, “Using the 
keyboard” and “Using a mouse”. Review these instructions with the respondent. 
Before continuing, make sure he or she understands these instructions.
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Verbal/Performance Instructions

Click on the Next button to continue. The Verbal or Performance instructions 
are then displayed. If no verbal tests are selected, then the verbal instructions 
are skipped. Similarly, if no performance tests are selected, the performance 
instructions are skipped. The verbal and performance instructions are accompanied 
by practice questions.

The practice problems are similar to the actual items. However, they are not timed 
and a hint box provides additional help.

Click on the A, B, C, D, or E button to answer the question. A check mark will appear 
next to the letter chosen. To erase an answer, click on the button again. Click on the 
Next button to continue to the next question. To go back to a previous question, 
click on the Previous button when it is available. Help is available by pressing 
the Help button. After exiting the help screen, the respondent is returned to the 
question where he or she left off.

After answering the practice questions, a screen with the title, “Are you ready?” 
is displayed. If the respondent is ready, press the Next button. Use the Previous 
button to go back and return to the practice problems.
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Performance Images

For proper display of the performance images, a fast CPU, hard disk and video 
card are required. Slow display of these Performance images will have a negative 
impact on the respondent’s results. If your computer is too slow, make sure that 
the Show Performance Images check box in the Options|Administration is not 
checked. Use the images in the MAB-II Performance test booklet instead.

Tests

Each test begins with an instruction screen and practice question(s). Review the 
information with the respondent and make sure he or she is comfortable with the 
practice problems. The practice problems are followed by an “Are you ready?” 
screen. After pressing “N” to select the Next button on the “Are you ready?” 
screen, the timed test begins.

Sample Test Screen

The test screen consists of an information section, a question and answer section 
and a button section. The test name and time remaining are displayed in the 
window title. The information section at the top contains the question number 
in the upper left corner and a brief instruction on the current test. Five possible 
answers are listed in the middle of the window. Use the A, B, C, D and E buttons 
beside those possible answers to record your choice. The button section at the 
bottom of the window contains Previous, Help and Next buttons.
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End of Tests

After answering all of the questions, the final screen allows the respondent to 
review the answers.

After the timer reaches seven minutes, a message will be displayed.

Press the F key to finish. The Check password at administration end check box is 
checked in the Options|Administration window, the password will be requested 
before returning to the Edit Respondent window. The password will also be 
requested if you exit early from the test using the Alt-F4 shortcut.
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Edit Responses

Use this window to transcribe responses from a pencil/paper administration or 
to check imported or administered responses for errors. Each test is separated 
and indicated with a heading.
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Edit Responses window

Edit Window
The Edit Window on the left side of the form allows you to change the responses 
using the keyboard or the mouse. To see more responses, use the scroll bars to 
the right and bottom of the Edit Window, or use the arrow keys.

To edit responses with the keyboard:

Up key		  Move up one item.
Down key	 Move down one item.
A,B,C,D,E	 Change response to A, B, C, D, or E.
Spacebar	 Indicate blank responses.
Home key	 Move to the first item.
End key	 Move to the last item.
PgUp key	 Move to the previous test.
PgDn key	 Move to the next test.

To edit responses with the mouse:

To select a response, click on the number beside response.
To change a response, click on the colored response box beside the number.
Click on the scroll bars to reveal more responses.

Yes button
Keeps changes and returns to Edit Respondent window. Note that changes are not 
yet saved until you click on the Yes button in the Edit Respondent window. If the 
responses are changed, the coupon level of the respondent will be reset to zero.

No button
Abandons any changes to the responses. You are warned if data will be lost.

Remaining Blank
Sets to blank the remaining invalid entries in the current test.

Errors only
When checked, the Errors only check box allows you to change only those responses 
which are in error. This allows you to quickly go to and fix invalid responses only.
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Edit Scale Scores

In special situations, you may need to be able to examine and possibly change 
scale scores directly. The Edit Scale Scores window allows you to do this.

Edit Scale Scores window

Scale Scores 
window

Select the edit box corresponding to the scale you wish to change, and enter the 
new value.

Yes button
Keeps changes and returns to Edit Respondent window. Note that changes are not 
yet saved until you click on the Yes button in the Edit Respondent window. If the 
scale scores are changed, the coupon level of the respondent will be reset to zero.

No button
Abandons any changes to the scales. You are warned if data will be lost.
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Report

Select the type of report you wish to generate from the Report Type dialog box. 
The Generating Report window displays basic respondent information and current 
scoring level. Select from the available buttons to generate reports for some, none, 
or all respondents.

Report Type

Select the type of report you wish to generate in the Report Type window.

Report Type window

Clinical Report
The MAB-II Clinical report consists of a summary of the respondent’s results, 
profiles of scores on the administered MAB-II tests and batteries, test descriptions, 
profiles of differences between the respondent’s test scores, interpretive text and 
a table of responses.

The cost of a Clinical report is 7 coupons.

Note: If tests from only one battery (Verbal or Performance) have been administered, 
the cost of this report is only 4 coupons.
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Extended Report
The MAB-II Extended report consists of an introduction, a profile of the respondent’s 
scores on the administered MAB-II tests and batteries, test descriptions, and a 
professional file summary consisting of score profiles and a table of responses.

The cost of an Extended report is 5 coupons.

Note: If tests from only one battery (Verbal or Performance) have been administered, 
the cost of this report is only 3 coupons.

Basic Report
The MAB-II Basic report consists of an introduction, a profile of the respondent’s 
scores on the administered MAB-II tests and batteries and a table of raw responses.

The cost of a Basic report is 3 coupons.

Note: If tests from only one battery (Verbal or Performance) have been administered, 
the cost of this report is only 2 coupons.

Data Report
The Data report contains demographic information, item responses, MAB-II scale 
scores and other results condensed to a single page in a program readable format.

The cost of a Data report is 2 coupons.

Note: If tests from only one battery (Verbal or Performance) have been administered, 
the cost of this report is only 1 coupon.
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Data Report Structure

Each line in the data report contains a three character token, an equals sign and 
a number or string of characters representing the value of that token. Each token 
and a description are listed in the chart below.

LNM		  Last Name	
FNM		  First Name	
MNM		  Middle Name	
IDN		  ID Number	
SEX		  Gender	
AGE		  Age

INF		  Table of Information Responses, separated by a comma 
and a space.	

COM		  Table of Comprehension Responses	
ARI		  Table of Arithmetic Responses	
SIM		  Table of Similarities Responses	
VOC		  Table of Vocabulary Responses	
DIG		  Table of Digit Symbol Response	
PCM		  Table of Picture Completion Responses	
SPA		  Table of Spatial Responses	
PAR		  Table of Picture Arrangement Responses	
OBJ		  Table of Object Assembly Responses
	
			  The Raw Scores, Standard Scores and Percentiles 

are ordered as follows: (Verbal:) Information, 
Comprehension, Arithmetic, Similarities, and Vocabulary, 
(Performance:) Digit Symbol, Picture Completion, Spatial, 
Picture Arrangement, and Object Assembly.

	
RAW		  Raw Scale Scores	
SSC		  Scale Standard Scores	
ASC		  Age Standard Scores	
APC		  Age Percentiles

			  The Battery Raw, Standard, IQ and Percentile Scores are 
ordered as follows: Verbal, Performance, and Full Scale.

	
BRW		  Battery Raw Scores	
BSC		  Battery Standard Scores	
BIQ		  Battery IQ Scores	
BPC		  Battery Percentiles	
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Import/Export File Formats

The exported files contain data for responses and scales.  If the Basic report has 
been purchased for the respondents output, then the export file will contain all 
the data that is also contained in the Data Report in the formats below.  The extra 
data will not be exported without the purchase of at least a Basic Report.  This 
allows the administrator to import respondent data into an external software 
program like Microsoft Excel.

There are three ASCII based file formats suitable for importing and exporting 
respondent data. They are:

	 Comma Delimited File Format (.CSV)
	 Tab Delimited File Format (.TAB)
	 Fixed-Format ASCII File Format (.TXT)

Comma Delimited 
File Format (.CSV)

Comma Delimited files contain one record per line. Each record is separated by 
a CR/LF (Carriage Return/Line Feed sequence - ASCII #13 and #10). Each field is 
separated by a comma (“,” - ASCII #42).
 
Field Name	 Type	 Comment	
First Name	 String		
Last Name	 String		
Middle Name	 String		
ID Number	 Number		
Gender	 String	 M or F	
Age	 Number		
Responses (335)	 Character	 Each response is either A, B, C, D, 

E or * if missing, each in its own 
field.	

Scale Scores (10)	 Number		
Reserved (3)	 Number	 For internal use only. Set to zeroes 

when creating the file, and do not 
modify when editing.	

If the field name has a number in parentheses, that field is repeated that number 
of times. For example, there are 10 separate scale scores, each separated by a 
field delimiter - a Comma in this case.

Tab Delimited File 
Format (.TAB)

The Tab Delimited file format is the same as the Comma Delimited file format with 
the exception that each field is separated by a Tab (ASCII #9) instead of a Comma.
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Fixed-Format ASCII 
File Format (.TXT)

The Fixed-Format ASCII file format contains extra fields which are not used by the 
software but are kept to be compatible with scanning utility file formats, notably 
those used by Scantools (R).
 
Field Name	 Width	 Comment	
First Name	 25		
Last Name	 25		
Middle Name	 25		
ID Number	 15		
Age	 2		
Gender	 1	 M or F	
Responses (335)	 1	 Each response is either A, B, C, D, E 

or * if missing.	
Scale Scores (10)	 2		
Reserved (3)	 5	 For internal use only. Set to zeroes 

when creating the file, and do not 
modify when editing.

If the field name has a number in parentheses, that field is repeated that number 
of times. For example, there are 10 separate scale scores, each of width 2.
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Generating Report

When you create reports of selected respondents, each respondent is displayed 
before the report is generated in the Generating Report window.

Generating Report window

Yes button
Click the Yes button to generate a report for the current respondent.

No button
The No button skips the current respondent and moves on to the next selected 
respondent.

All button
To generate reports for all of the selected respondents without further confirmation, 
click on the All button.

Abort button
To cancel any further reports, click on the Abort button.
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Progress Indicator
The progress indicator location at the bottom left of the window displays the 
progress for the report being generated. The number of coupons remaining is 
displayed and updated as the coupons are used.

Send Report To
The Send Report To radio box allows you to choose where the report is sent. This 
choice overrides the one made in the Printer and Page Setup window for the 
current report only. Click on Output window to send the report to the Output 
window. Click on Printer to send the report directly to the printer selected in the 
Printer and Page Setup window.

Confirm Processing

When you import respondent data and delete respondent data, you are presented 
with similar windows: the Import Respondent Data window and Delete Respondent 
Data window. From these windows you can choose to continue or abort processing.
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Import / Delete Respondent Data window

Yes button
Click the Yes button to continue processing the current respondent.

No button
The No button skips the current respondent and moves on to the next selected 
respondent.

All button
This button is present when there is more than one respondent selected. To process 
all of the selected respondents without further confirmation, click on the All button.

Abort button
This button is present when there is more than one respondent selected. To cancel 
any further processing, click on the Abort button.
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Combine Verbal and Performance Data

If you are importing records from separate scanned verbal and performance 
sheets, you will need to combine them for a full report. The Combine Verbal and 
Performance Data window allows you to automatically combine the data, or do 
so manually.

Verbal only
This section lists the respondents which have been determined to contain verbal 
responses only.

Performance only
This section lists the respondents which have been determined to contain 
performance responses only.
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Both Verbal and 
Performance

This section lists the respondents which have been determined to contain both 
verbal and performance responses.

Automatic
Click on the Automatic button to have the MAB-II Software automatically combine 
verbal and performance responses. A search is performed on the name and id 
number and if there is a match in the Verbal and Performance windows, the 
responses will be combined into on record and both respondents will then be 
listed in the Both Verbal and Performance window.

Combine
To manually combine the verbal and performance responses, select a respondent 
from each of the Verbal and Performance list boxes and click on the Combine button.

Split
Should you need to separate the verbal and performance responses from a test, 
select a respondent in the Both Verbal and Performance window and click on the 
Split button. The entry will be removed and the corresponding entries placed in 
the Verbal and Performance sections.

Sort
By default, the respondents are listed in the order that they were added to the 
database. If you wish to sort by last name, check the box labelled Sort. To return 
the list to its natural order, uncheck the Sort box.
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11. Help Menu
From the Help Menu, you may obtain detailed online help, learn to use the software 
through an online tutorial, or display program status information.

The items in the Help Menu are:
	 About	
	 Contents
	 Tutorial	

Help|About

The content of the Help|About window depends on what mode the software is 
running in:
	 Registered Mode
	 Demonstration Mode
	 Server Mode
	 Client Mode

Registered Mode
The About dialog box displays version and status information about the SigmaSoft 
for Windows Software. The button labeled Change allows you to change your 
registration information, such as your company name or address.

Demonstration 
Mode

If you have not registered the software, it will run in demonstration mode only. 
When in demonstration mode, the About dialog box requests that you continue 
evaluating the software by clicking Ok. You may register the software by pressing 
the Register button.

Server Mode
The computer which was used to register the software will run in Server mode. 
The mode in which the computer is operating is displayed in the title of the About 
dialog box. This is the only computer on which coupons can be added or used to 
generate reports.

Client Mode
Any computers attached to the Server computer will run in Client Mode (Network). 
The /N parameter allows you to configure where the Server is located. In this 
mode you can add, edit and delete respondents, and administer tests. You may 
not generate reports or add coupons from this computer. The mode in which the 
computer is operating is displayed in the title of the About dialog box.



Page 11-2

Help|Contents

This option displays the table of contents of the help file. From the table of contents 
you can see an overview of the topics in the help file.

Help|Tutorial

The online tutorial helps you learn how to use the SigmaSoft for Windows Software 
through sample lessons. You may begin by clicking on the word tutorial in the 
online help file.
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12. Batch Processing 
The topics in this section are:
	 Explanation of Command Line Parameters
	 Using Command Line Parameters in Windows

Explanation of 
Command Line 

Parameters
To simplify daily processing, the SigmaSoft for Windows software contains a feature 
that allows you to tell it, when you start it up, which options you want to use. 
This is done by adding switches to the command line used to start the software. 
An example command line is: “C:\PROGRAM FILES\MAB\MAB.EXE /DOSEP0196 /
RB /P /X”. This example would open the database named SEP0196.DAT, generate 
basic reports, print the reports, and then exit the program.

There is a command-line switch for each of the most-used options on the SigmaSoft 
for Windows Software menus. Many of the command-line switches also allow you 
to specify the information, such as the name of the respondent data file, import 
data file or export data file, required by the option.

Each switch can only be used once in a command line. Switches are processed 
in the order given below. If a switch contains a <Filename>, replace this with the 
filename you are using. For example, /DOCASEM will open a respondent database 
named CASEM.DAT.

Command	 Switch	 Notes

Open new respondent database	 /DN<Filename>	 Will overwrite existing databases 
without any warning. Uses the 
default directory unless another 
specified.

Open existing respondent database	 /DO<Filename>	 File must exist. Uses the default 
directory unless another specified.

Create new output file	 /ON<Filename>	 Clears Output window.

Load existing output file	 /OO<Filename>	 Clears Output window. Assumes 
extension of RTF. Uses the default 
directory unless another specified.

Import respondent data	 /I<Filename>	 Assumes extension of CSV if none 
provided. Uses the default directory 
unless another specified. Respondent 
database must already by open.

Combine data	 /C	 Display Combine Verbal and 
Performance Data window.
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Edit respondent data	 /E	 Selects all respondents in the 
Respondent Database window and 
calls up Edit Respondent window for 
each.

Administer MAB-II	 /A<1111100000>	 Selects all respondents in the 
Respondent Database window and 
administers the MAB-II to each. By 
itself, /A administers all 10 MAB-II 
tests. To select specific tests, add 
a combination of ten 0’s and 1’s to 
the /A. Use a 0 to deselect a test, 
a 1 to select it. For example, 5 1’s 
followed by 5 0’s (/A1111100000) 
will administer the 5 Verbal tests, 
but not the 5 Performance tests. The 
following example, /A0000010000, 
will administer only the 6th test, the 
Digit Symbol test.

Generate Clinical Report	 /RC	 Selects all respondents in the 
Respondent Database window and 
generates a clinical report for each.

Generate Extended Report	 /RE	 Selects all respondents in the 
Respondent Database window and 
generates an extended report for 
each.

Generate Basic Report	 /RB	 Selects all respondents in the 
Respondent Database window and 
generates a basic report for each.

Generate Data Report	 /RD	 Selects all respondents in the 
Respondent Database window and 
generates a data report for each.

Print report	 /P	 Sends report directly to printer 
selected in the Printer and Page 
Setup window.

Export respondent data	 /T<Filename>	 Selects all respondents in the 
Respondent Database window 
and exports each to file. Assumes 
extension of CSV if none provided.

Exits program	 /X<A>	 /X automatically exits the MAB-II 
program when all of the above 
commands have been executed. 
In addition to exiting program, /XA 
automatically chooses the default 
option in any dialog boxes that open 
up during processing. Use this option 
to completely automate processing.

Network mode	 /N<Path>	 Specify path of network server. If the 
path contains spaces, enclose the 
path in double quotation marks ("). 
UNC paths are not supported, drives 
letters must be mapped.
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Using Command 
Line Parameters in 

Windows
There are two ways to use the command line in Windows:

1.	 Permanently add the switches to the icon used to load the software:

i.	 Right click on the program icon,  and select Properties.

ii.	 Select the Target tab.

iii.	 Add a space to the Target edit box, and then add any command line 
switches. Note that if the text in the edit box is selected when you 
start typing, it will be replaced. Press the End key once to remove 
the selection while in the edit box.

iv.	 Click the Ok button.

2.	 Run the software with command line switches one time only:

i.	 Click on the Start Menu.

ii.	 Select Run.

iii.	 Type in the full path of the MAB-II program, for example: C:\PROGRAM 
FILES\MAB\MAB.EXE with a space at the end.

iv.	 To the same line, add any command line parameters and then press 
the Ok button.
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13. Troubleshooting
The error message will give you an indication of what went wrong and how you 
may be able to correct the error. You may wish to refer to the Troubleshooting 
section to fix the error yourself. Try the operation again to see if it produces the 
same result.

If you wish to call technical support, please record the error number and the 
circumstances under which the error happened. If possible, call from a phone near 
the computer so that any assistance given can be tested immediately.

The topics in this section are:
	 Administration
	 Client mode
	 Coupons
	 Editing respondent data
	 Exporting reports and respondent data
	 Generating reports
	 Importing respondent data files
	 Keyboard usage
	 Memory
	 Missing files
	 Mouse usage
	 Network
	 Opening files
	 Password
	 Performance Images
	 Printing
	 Registration
	 Saving files
	 Saving reports
	 Window appearance
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Administration
Exit all unnecessary programs before administering the test from the Edit 
Respondent window. This includes programs that have the Always on top mode 
set. These programs will remain displayed while the test is administered, distracting 
the respondent. For example, help files or clock programs often have this mode set.

Whenever you edit a respondent’s data, or administer the MAB-II, the changes 
you make are stored in a file called BKddhhmm.CSV, where dd is the date, and 
hhmm is the hour and minute the file was created. If your computer crashes or you 
forget to save your changes, all is not lost. Simply import this file to retrieve your 
latest changes. More information on importing can be found in the File|Import 
section. To enable or disable file backups, refer to the Options|Program section.

If you have problems starting the administration or viewing the test instructions, 
you may need to change the administration font. See the Administration Font 
section under Options|Administration.

Client Mode
When you are running the software on a network in client mode (as opposed 
to server mode), you may edit and manipulate respondent data, and generate 
reports, but you may not use coupons. This means you may not generate a report 
for a respondent with a coupon level of less than the number required for the 
report you wish to generate.When configured properly, the Help|About screen 
will display Client Mode (Network).

If your software has been registered, and suddenly comes up in Client Mode, or 
you cannot generate reports due to a coupon protection error, you will need to 
re-register your software to regain your coupons.

Coupons
If you need to remove coupons to add them to another computer or move the 
software to another computer, contact technical support.

If the title of the startup screen contains the words Client Mode then you may 
not use coupons from that computer. You can only use coupons on the computer 
displaying Server Mode. If you do not have a network, the computer will always 
run in Server Mode.

Editing respondent 
data

If you cannot open a database or record, it may be in use over the network. If so, 
try later when the file or record becomes free.

If the database becomes excessively large, you may notice slowdowns when editing 
respondents. Create a new database if this is the case.
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Exporting 
respondent data

If the disk is full or write-protected, refer to the Saving files section. Data is exported 
to the import directory shown in the Options|Program menu option. 

See also: File|Export

Generating reports
Ensure that you have enough coupons to pay for the report you wish to generate. 
If not, you may need to add coupons. The software must be registered before you 
can generate reports.

Importing 
respondent data 

files
Files are imported from the import directory as listed in the Options|Program 
menu option, but you may change this to any directory temporarily or permanently. 
Change the List files of type list box to the type of file you wish to import. The file 
extension (.CSV, .TAB, .TXT) must properly reflect the type of file being imported. 
If no records are imported, it may be that the file is not in the proper format.

See also: File|Import

Keyboard usage
For the most part, you can press only the key corresponding to a letter underlined 
on a button. However, if you are in an edit field or another part of the window, 
you may have to use the Alternate combination. For example, if O is underlined, 
press and hold Alt, and press O.

Memory
You need at least 4 megabytes of RAM installed in your computer to run this 
software. If you are running out of memory, exit other programs and try again. 
Consult your Windows manual on how to increase virtual memory if necessary.

Missing Files
Refer to the list of files used by this software. If any are missing, you may need 
to re-install the software. If you have registered the software or added coupons, 
they will be preserved, provided you re-install to the same directory.

Mouse usage
When clicking on a button, ensure that the mouse is released before moving off 
the button completely, otherwise the button may not work.

Network
A peer-to-peer network (such as Windows) is required to run the SigmaSoft for 
Windows Software.



Page 13-4

If you are experiencing write errors, ensure that the server computer is allowing 
full read/write access to the client computers, and that you are using a mapped 
network drive, and that you are using a mapped network drive.

Opening files
If you cannot open a file, check the spelling of the file, or choose from the file 
open dialog box. Ensure that the file is not already in use if you are on a network, 
and if so, try later when the file becomes free.

See also: File|Open

Password
If you have forgotten or lost the start up and administration password, call technical 
support to obtain a temporary password to gain access to the program. Use the 
Options|Program menu to re-enter the password. Temporary passwords will only 
be given to registered users.

See also: Options|Program

Performance 
Images

If the performance images take too long to display, disable the display of images 
by removing the check mark beside the Show Performance Images check box in 
the Options|Administration window. Use the images in the MAB-II Performance 
test booklet instead.

Printing
Refer to your printer manual or the Windows manuals for problems with your 
printer. Check that the cables are properly connected, and that power is applied 
to the printer. Also check for a paper jam or paper tray empty.

If pages are not formatted properly, it may be due to the font size or type. Select 
a different font or font size, or adjust the margins.

See also: File|Print, Printer and Page Setup, Options|Report

Registration
Registration may be performed only on a local drive on a local computer; you may 
not register on a drive that is on a network location.

Ensure that you are entering the proper password when registering the software. 
If you enter too many incorrect attempts, you will no longer be able to use that 
password, and must obtain a new password.

Saving files
If you cannot save a report file or database to disk, the disk may be write-protected 
(if a floppy disk) or full. Use the windows file manager to check for disk space, 
and remove any files in your TEMP directory if necessary to free up some space. 
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If it is a write-protected floppy disk, remove the protection, or use a disk that is 
not write-protected.

If you are on a network, you may not have save privileges to a disk drive, and may 
have to use your local drive to save data. You can change the default directories 
in Options|Program.

See also: File|Export, File|Save, File|Save As

Saving reports
If the disk is full or write-protected, refer to the Saving files section. Reports are 
saved to the Output Directory shown in the Options|Program Program Directories.

Window 
appearance

If you rearrange the Output and Respondent Database windows, you can restore 
them to the default sizes by selecting Window|Output or Window|Respondent 
Database menu options. The screen font used for buttons and window text can 
be changed in Options|Program.
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14. Files Used by 
the Software
Listed below are the files needed by and created by this software:

MAB.EXE		  Main executable software
MAB.HLP		  Help file

BK*.CSV		  Backup files containing saved responses from the most 
recent administration.

MABADMIN.CDN,
MABADMIN.USA	 Administration files for CANADA and U.S.A.

CONFIRM.TPL,
CONFIRM.TXT		  Coupon removal confirmation template and form.

COUPON.TPL,
COUPON.TXT		  Coupon order template and form.

DL*.CSV		  Backup file containing respondents most recently deleted 
from a database.

REG.TPL,
REG.TXT		  Registration order template and form.

SAMPLE.DAT		  Sample respondent database file.

SIGMAMAB.DAT		  Protected files, do not modify, delete or move.

KEYLIB32.DLL,
MACHNM1.EXE,
TER.DLL,
TOC.OCX,
UNSIGMA.EXE		  Library files common to all SigmaSoft for Windows 

Software.

Here are the common file extensions used by this program:

*.DAT		  Respondent database files.
*.CSV		  Comma delimited import/export files.
*.RTF		  Rich text report files.
*.TAB		  Tab delimited import/export files.
*.TXT		  Text report files or fixed format import/export text files.
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15. Uninstallation
When the SigmaSoft for Windows Software is installed, it sets up an uninstall 
method to simplify removing coupons and all program files that were added to 
your system. You will need to uninstall your software so that you can reinstall it 
on another computer if you want to change the computer on which you generate 
your reports.

The topics in this section are:
	 Uninstallation for Windows
	 Remove Registration

Uninstallation for 
Windows

1.	 From the Start Menu, select Settings.

2.	 Select Control Panel.

3.	 Select Add/Remove Programs.

4.	 From the list of programs installed, select SigmaSoft MAB-II for Windows, 
and click the Add/Remove button.

5.	 Press the Ok button to continue uninstall, and press the Yes button to confirm 
uninstallation.

6.	 Proceed to the Remove Registration section.
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Remove 
Registration

1.	 After uninstallation, the Remove Registration window is displayed.

2.	 Follow the instructions in the Remove Registration window to obtain the 
unregistration password.

3.	 Enter the unregistration password in the Password edit box.

4.	 Press the Now button. The Registration Password window is displayed next.

5.	 Record the confirmation number on paper. Press the Record button to save 
the confirmation number to disk.
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6.	 You will be asked if you wish to print out the confirmation number, answer 
Yes if you wish to do so.

7.	 Give the confirmation number to SIGMA to record a credit. If you are moving 
the software to another computer, contact SIGMA after you have re-installed 
the software and are ready to register. You may then add back the credited 
coupons.
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16. Glossary 
Browse box

The browse box allows you to select a directory. Double-click on a folder to open 
it and display the sub-directories. Use the scroll bar to display folders past the end 
of the box. Double-clicking on an open folder closes it.

Button bar
The button bar sits just below the menu items, and contains frequently used 
speed buttons to be used with a single click of the mouse. If you move the mouse 
overtop a button and let it rest for a moment, a brief description of the button is 
displayed. If a button is not available for the current operation, it is greyed out.

Check box
A check box is a box in which you place a check mark by clicking the empty box 
when you want to enable it. To disable the function, click the check mark again 
to remove it. A description of what the box does lies to the right of the box itself.

Clipboard
The clipboard is a temporary container for text or other objects which can then 
be pasted or copied to another location.

Comma delimited
Comma delimited files are saved with each field separated by a comma, and each 
record separated by a carriage return.

CONFIRM.TXT
The CONFIRM.TXT file contains the Coupon Removal Confirmation Form for use 
when faxing, mailing or e-mailing a request to remove coupons for transfer to 
another site or computer.
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Coupon level
The coupon level of a respondent refers to how many coupons have been spent 
on that respondent. When first added, each respondent is assigned a coupon level 
of zero (0). Each time a report is generated for a respondent, his or her coupon 
level is set to the number of coupons required by that report. Once a coupon level 
has been assigned, you may generate additional reports of the same or less value 
without using more coupons.

Coupons
Each report has a price, in coupons. Before you can generate a report, you must 
purchase enough coupons to pay for that report. These coupons are electronic in 
nature. When you purchase coupons, you receive a password. This password adds 
the number of coupons you have purchased to the protected counter installed 
on your computer. When you generate a report, coupons are subtracted from 
that counter.

COUPON.TXT
The COUPON.TXT file contains the SigmaSoft Coupon Order Form for use when 
faxing, mailing or e-mailing an order for additional coupons.

Dialog box
A dialog box is a window which usually contains Ok and Cancel buttons, or Yes and 
No buttons. It displays information or asks for more information before continuing. 
Click the Ok or Yes button to continue with the current operation. Click on the 
Cancel or No button to stop the current operation.

Drive icon
The drive icon allows you to select a drive. It is similar to a list box except that it 
displays all available drives. When you select a drive, the browse box changes to 
display the folders in the new drive.
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Edit box
In an edit box you type in numbers or characters. You may use the cursor or mouse 
to select and delete text within the edit box.

Fixed format ASCII
Fixed format ASCII files are arranged so each field is exactly the same length in each 
record, and each record is contained on one line, separated by a carriage return.

Highlighting
A button is highlighted when a dotted line appears along the inside borders of 
the button.

ID Number
The ID Number of a respondent allows you to assign a number to use for confidential 
purposes. Use a unique number for each respondent, or no ID Number at all.

List box
A list box allows you to choose from a list of items. Click on the down arrow to 
show the list and select an item from the list.

Radio box
A radio box contains more than one radio button. Clicking on a button releases 
all other buttons, leaving only one selected.

REG.TXT
The REG.TXT file contains the SigmaSoft Registration Form for use when faxing, 
mailing or e-mailing a Windows Software Registration form.
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Respondent data 
file

A respondent data file is a special file used by this program to store respondent 
demographic information, responses to the MAB-II items, as well as scoring 
information. Respondent data files should not be printed and cannot be accessed 
by other programs. By default, respondent data files are stored in the respondent 
data file directory listed in the Options|Program window.

RTF file
An RTF file is a Rich Text Format file which retains font sizes, and character effects 
such as bolding, italics and underlining. It can be read and written by many word 
processing programs.

Save dialog box
The save dialog box allows you to define the directory and file name in which 
the data will be stored. You may select a different output format by changing the 
list box labelled “Save file as type”. Click on the Ok button when you are ready 
to save the file.

Selection
To select an item, click on it or press the space bar when the item is highlighted. 
You can select a range of items by holding down the Shift key while selecting. You 
can select and deselect individual items by pressing the Ctrl key and selecting items.

Status bar
A status bar at bottom left shows the number of the currently selected records, 
the total number of records, and the number of selected records.

Validation code
The validation code is provided by the SigmaSoft for Windows Software during 
the registration process. This code is given to Sigma Assessment Systems who 
then provides a password to register your software.
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